
Introduction
For information about a previous software version, refer to the document: Release Notes that
came with that software version.

New in Analyst 1.7.3 HotFix 2 Release Notes
Enhancements
HotFix 2 includes the enhancements that were included in the Analyst 1.7.3 HotFix 1 as well as
support for the VICI Valco valve 2-position 10-port: UMDA-C10W.

Analyst 1.7.3 HotFix 1 Enhancements

The following enhancements were included in the Analyst 1.7.3 HotFix 1.

• The option to use the deployment tool to do a new install the Analyst software 1.7.3 with the
AAC security database is supported.

• Microsoft Office 2021 is supported. For a list of other supported versions of Microsoft Office,
refer to the software installation guide for the Analyst software 1.7.3.

• A new plate layout for the Shimadzu LC-40 autosamplers is now available.

The Alpha Deep Well MTP 96 plate, a 96 deep well plate layout with alphanumeric numbering
starting from the bottom left of the plate, horizontally, is supported for the Shimadzu LC-40
autosamplers. (AN-2758)

• A new plate layout is now available for the Shimadzu SIL-30AC and SIL-30ACMP
autosamplers configured through the Integrated System Shimadzu LC Controller or the
Integrated System Shimadzu LC-20/30 Controller, with or without the RackChanger.

The Alpha Deep Well MTP 96 plate, a 96 deep well plate layout with alphanumeric numbering
starting from the bottom left of the plate, horizontally, is supported. (AN-2223)

• The SIL-30ACMP autosampler can now be controlled using a Shimadzu LC-40 controller
(AN-2707, AN-3037)

• The Analyst Administrator Console (AAC) 3.1 client is installed with the installation of Analyst
1.7.3 HotFix 1. (AN-2836)

• The ExionLC 2.0 system firmware has been updated.

Contact sciex.com/request-support to update the device firmware.

• Use firmware version 6.21 for ExionLC 2.0 column switching valves.
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• Use firmware version 1.23 for ExionLC 2.0 autosamplers.

Fixed Issues
The Analyst software stopped working when users printed from the File > Print >
Workspace

If data, such as methods or Results Tables, was printed from the File > Print > Workspace,
then the Analyst software stopped working even though the data was printed successfully. There
is no issue if users print from the File > Print > Window or File > Print > Pane. (AN-2079)

The Quantitation Wizard added an incorrectly selected sample if one of the datafiles had a
checksum error

In Quantitation Wizard, if users clicked Add All Files to add multiple datafiles to the Selected
Samples list, and if one of the datafiles had a checksum error, then the datafile with a checksum
error was not added but the sample from the next datafile that had a valid checksum or had no
checksum was added twice. (AN-1653)

If data was being acquired with the Shimadzu or ExionLC PDA module in 2D mode with
the slow sampling rate, then data acquisition occasionally stopped at the end of the run
and did not move to the next sample

If an acquisition method that included a Shimadzu or ExionLC PDA module used the slow
sampling rate, such as 2000 ms in 2D mode, to acquire data, then acquisition might have
become stuck at the end of the run and did not move to the next sample in the batch. (AN-2980,
AN-2975)

Users assigned a non-administrator role that had Overwrite Acquisition method access
enabled but did not have delete rights enabled for the Analyst Data folder could not
overwrite methods in Tune and Calibrate mode

A user with a non-administrator role that had Overwrite Acquisition method access enabled
but did not have delete rights enabled for the Analyst Data folder could overwrite acquisition
methods in Acquisition mode but not in Tune and Calibrate mode. (AN-2732)

If an internal standard was defined in the second period, then it could not be selected for
use in the first period in the Analyst software 1.7.3 quantitation methods

If a user was making a quantitation method in the Analyst software 1.7.3 with or without HotFix 1
installed, then if the internal standard was defined in the second period, it could not be selected
for use in the first period. (AN-2979)

Corrupted audit trail records might have been shown when special characters were used
in the Change Description

If special characters such as a carriage return or a new line were used in the Change
Description for an audited event, then corrupted audit trail records might have been shown.
(AN-2733)
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The Analyst software audit trail records showed the full name of the user instead of the
display name

In the Analyst software versions 1.7.2 and 1.7.3 with or without HotFix 1 installed, the Full User
Name field in the audit trail records showed the full names of the users instead of the Display
Names that were stored in the Windows Server Active Directory. This behavior was different
from what was shown in versions before 1.7.2. After the fix, the Display Names are shown in
the Full User Name field in audit trail records. (AN-2447)

The File Info might show incorrect information for some Agilent pumps that were directly
controlled by the Analyst software

If Agilent 1260 pumps were directly controlled by the Analyst software and not controlled using
the Analyst Device Driver, then the values for the Max Pressure Ramp and Max Flow Ramp
reported in the File Info were interchanged. In addition, the Max Flow Ramp Up and Max Flow
Ramp Dn information was shown in the File Info for all Agilent pump models that were directly
controlled by the Analyst software even though they only applied to the Agilent 1290 G4220A
and Agilent 1290 G4220B pump models. (AN-2754)

A target project was not made if there was a double backslash in the middle of a network
path for the Project Source Directory and Project Destination directory

The Analyst software does not generate a double backslash (\\) in the middle of a network path
for a project. However, for some reason, if the user copied a project in the Analyst software, and
if a \\ was in the middle of a network path in both the Project Source Directory and Project
Destination directory fields, then the Analyst software was unable to make the target project.
The workaround was to replace the double backslash (\\) with a single backslash in the Project
Source Directory field. (AN-2568)

The toolbar in the Analyst software did not refresh correctly after the user clicked the
icon for the Administrator Console Connectivity Settings.

In Configure mode, after the user clicked the icon for the Administrator Console Connectivity
Settings in the toolbar, the right side of the toolbar, where there are no toolbar icons, could not
be seen.
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Figure 1 AAC Icon (Old)

This issue is fixed in this release. This HotFix introduces a new icon, shown in the following
figure, for the Administrator Console Connectivity Settings and a tooltip, AAC settings.

Figure 2 AAC icon (New)

(AN-1204)

Positive and negative spikes could have been shown in PDA data acquired in 2D mode

If PDA data was acquired in 2D mode with a Shimadzu SPD-20 or SPD-30 configured through
the Integrated System LC-20/30 Controller, or a Shimadzu SPD-40, or an ExionLC PDA, then
positive and negative spikes could have been shown if the acquisition method used a high
sampling rate and included more than one channel. (AN-3022)

A user could still use the Analyst software in Mixed Mode after the Analyst software had
been screen locked
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If a user logged on to the Analyst software workstation using a VPN, or disconnected from the
network when the Analyst software screen was locked, then an Unspecified error message
was shown. If the user waited for approximately 20 seconds, and then clicked OK in response to
the error message, then the unlock screen dialog was shown. However, the user still could use
the Analyst software while the unlock screen dialog was shown. (AN-3004)

Users might have not been able to edit or create report templates in Microsoft Office

On a workstation with Microsoft Office 2013, 2016, 2021 or Office 365 installed, and with
a very high level of security policy applied, users might have gotten a certificate error for
TemplateContentControlManager.vsto when they tried to open any reporter template for
the first time on the computer. As a result, this add-in required for editing templates could not be
installed because the file TemplateContentControlManager.vsto was not digitally signed.
After this HotFix is installed, users can install this add-in with Microsoft Office 2013, 2016, 2021
or Office 365. Users can also edit or make a report template in Microsoft Office 2013, 2016, and
2021. Depending on the version of Office 365, users might not be able to edit or make a report
template in Office 365. If this issue occurs, then contact sciex.com/request-support. For more
information, refer to the section: Notes on Use. (AN-3202)

The Analyst Reporter might have grouped some analytes incorrectly and might not show
data for some of the analytes

This issue occurred if analytes that belonged to different analyte groups had names that started
with the same characters and one of these analytes ended in 1. For example:

• Morphine 1

• Morphine 2

• Morphine Dihydro 1

• Morphine Dihydro 2

These analytes should be in two separate analyte groups, but the Analyst Reporter incorrectly
put all of the analytes in one group. In addition, some of the analytes were not printed in the
report. Instead, one of the analytes was reported multiple times to replace those that were not
reported.

After the fix is installed, if analytes are to be included in same analyte group, then the analyte
names must end with a space and then an integer, and the characters from the start of the
analyte name to immediately before the last space character must be the same. Analyte names
have always been case sensitive. Thus, Morphine 1 and Morphine 2 are in the same group,
and Morphine Dihydro 1 and Morphine Dihydro 2 are in the same group. However, analytes with
names such as QAXL 357 1 and QAXL 225 2 would not be in the same group. To put these
analytes in the same group, the user must rename the analytes. (AN-1645)

If a Reporter template was made with a newer version of Microsoft Word, then an extra
empty line might be printed for each analyte or sample
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SCIEX has tested versions of Microsoft Word from 2016 and 2021. If the For Each tag was
used in a Reporter template that was made with a newer version of Microsoft Word, then the
printed Results Table report might contain an extra empty line for each analyte or sample. If
the If condition was not met for some analytes or samples, then the report contained a large
blank space between analytes or samples, depending on how many samples or analytes did not
meet the condition. This issue occurred because newer versions of Microsoft Word introduced
a hidden empty line after the For Each tag. The empty line could not be removed when the
template was made because the line was hidden. (AN-3104)

The exported text file and PDF file for a Results Table showed an error if the Analyte
Slope Baseline column data started with a -7

If a value in the Analyte Slope Baseline column of a Results Table started with –7, for example
–7.0054e001, then the exported text file and PDF file of the Results Table showed #DIV/0!
for that value. (AN-3254)

Issues Fixed in HotFix 1 and Included in this HotFix
Shimadzu LC-40 systems: The Analyst software batch stopped intermittently if non-
default values for the autosampler rinse mode and rinse method were selected

If the Shimadzu LC-40 system was used with the Analyst software 1.7.3, then the batch might
stop if, in the LC method, non-default values were selected for the autosampler rinse mode
and rinse method. (AN-2901)

Batch submission failed when a specified rack was selected in the acquisition method for
Shimadzu 20/30 autosamplers that had a rackchanger configured for use

If a Shimadzu autosampler with a rackchanger that was configured for use through the
Integrated Systems Shimadzu LC20/30 Controller was used, then the batch submission failed if
the Specify Rack option was selected in the acquisition method. (AN-1806)

Batch submission might have failed if a specified rack was selected in the acquisition
method for Shimadzu 20/30 autosamplers that did not have a rackchanger configured

If a Shimadzu autosampler that did not have a rackchanger configured through the Integrated
Systems Shimadzu LC20/30 Controller was used, then the batch submission failed if the
Specify Rack option was selected and Rack 1.5 mL 105 vial or Rack 1.5 mL 70 vials was
used in the acquisition method. (AN-2805)

If the Analyst Classic quantitation algorithm was used to quantitate poorly separated
small peaks, then a smaller peak area than expected might be calculated when an
atypically large value for the Separation Height or Separation Width was used for
integration

If the Analyst Classic quantitation algorithm was used to calculate the area of a small peak that
is on the shoulder of a large peak that eluted before or after the small peak, then the automatic
integration that used an atypically large value for the Separation Height parameter, such as
0.6 (default is 0.01), or the Separation Width parameter, such as 4.0 (default is 0.2) could
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cause the peak area to be calculated with a lower value than if the peak area was integrated
manually.

This issue might only occur if peaks that are not well separated are integrated. The issue has
been fixed for any Results Table that is made using the Analyst 1.7.3 HotFix 1 or later. If a
Results Table was created using the Analyst software, version 1.7.3 or an earlier version, then
opening or editing the Results Table or updating other integration parameters in Analyst HotFix 1
or a later version will not cause the new peak area calculation. To update the calculation for an
analyte, in the Results Table, change the quantitation method by removing the analyte and then
adding the analyte back. Click Tools > Results Table > Modify Method. The peak area will be
calculated for the newly added analyte. (AN-2844)

In the Analyst Administrator Console (AAC) users could add projects from multiple
Project Roots but the Analyst software could only access projects from one Project Root

In the AAC, the Workgroup > Projects node let projects from multiple Project Roots be added.
However, in the Analyst software, only projects in the Project Root that was created first were
accessible by the user. In the Analyst 1.7.3 HotFix 1 and later versions, the user can access
projects from different Project Roots using the Root Selection dialog when the Analyst software
is opened. (AN-2565)

Opening the File Info pane when multiple data files were open in the Analyst software
Explore mode might slow system performance

If different data files were open in Explore mode, if each of the data files had File Info open, and
if the user clicked Show Next Sample, Show Previous Sample, or Go To Sample to move to
a different sample for one of the data file windows, then the system performance might be slow
when the File Info pane was updated. (AN-2843)

Deactivating a hardware profile that included the ExionLC 2.0 system might intermittently
fail

Intermittently, when a user tried to deactivate a hardware profile that included the ExionLC 2.0
system, the following error messages are shown: The remote procedure call failed or
The RPC server is unavailable. To resolve this issue, close and then open the Analyst
software. (AN-2766)

Analyst 1.7.3 Patch for Shimadzu LC30 & LC40 Plate Layout (AN-2771)

This patch is included in HotFix 1. The patch gives support for a new plate layout for
the Shimadzu SIL-30ACMP and Shimadzu SIL-30AC autosamplers configured through the
Integrated System Shimadzu LC Controller or the Integrated System Shimadzu LC-20/30
Controller, and for supported Shimadzu LC-40 autosamplers (AN-2223, AN-2758).

• 96 deep well plate layout with alphanumeric numbering starting from the bottom left of the
plate. The following Rack Codes are available in the Batch Editor:

• Shimadzu SIL-30ACMP and SIL-30AC: Alpha Deep Well MTP 96

• Shimadzu LC-40 autosamplers: Alpha DWP 96
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The following are applicable when the new plate is selected for the Shimadzu SIL-30ACMP and
Shimadzu SIL-30AC autosamplers, or for a supported Shimadzu LC-40 autosampler:

• The locations in the Batch Editor are assigned numeric values, arranged horizontally.

• The Batch Editor supports the "fill down" feature.

• The Batch Editor can export to txt and csv files.

• The Batch Editor can import from txt and csv files.

Notes on Use
The Print Automatically function in Analyst Reporter does not print HTML reports

If Analyst Reporter is used to make reports and the output format Html is selected, then
do not select the Print Automatically check box. Although an HTML report can be created
successfully, the Print Automatically function does not operate because of limitations in the
Windows 10 operating system. To print documents automatically, select the Word or Pdf output
format. If the output format is PDF and Print Automatically is selected, then make sure that
Adobe Reader is set as the default program to open PDF files. (AN-3279)

File Info has been changed for the VICI Valco 2-position 10-port valve

For data files acquired in Analyst 1.7.3 HotFix 2 or later, the following updates have been made
to the information for the Valco valve in the File Info:

• ver has been changed to FW version, and the firmware version of the device is shown in the
FW version field. Previously, the ver field was empty and the firmware version was shown in
the S/N field.

• N/A is shown in the S/N field, because the serial number is not available from the Valco valve
firmware. Make sure to record the device serial number from the hardware label. (AN-3220)

Workstation recommendations

If a customer-supplied computer is used with the system, then a best effort will be made to
support and troubleshoot any issues. However, in some cases, a standard SCIEX-supported
computer configuration will be required for further investigation.

Network Environment

The Analyst software supports the Windows-based LAN networks.

File Server

The Analyst software only supports Windows-based file servers. We recommend that the file
server be in the same building as the mass spectrometer. Contact Microsoft or the hardware and
software vendors for specification recommendations.
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Note: Previously, Windows Server 2008 R2 and 2012 were specifically mentioned. During
testing we have found that compatibility is not version-dependent.

Microsoft Office compatibility

Microsoft Office 2013, 2016, or 2021 is required to make, open, or edit the report templates
used in the Reporter software. The Analyst software is compatible with Microsoft Office 365 for
all functions except creating, opening, and editing the report templates used in the Reporter
software.

Shimadzu LC-40 PDA (SPD-M40) data might show small artificial regular spikes using
firmware version 2.00

If firmware version 2.00 is used for the Shimadzu SPD-M40 detector, then the data might show
small artificial regular spikes. The frequency of the spikes or valleys is related to the sample
speed of the PDA method. Make sure to use firmware (ROM) version 2.07 or higher for the
Shimadzu SPD-M40 detector.

Different autosamplers permit different injection volume ranges and precisions

The injection volume controls the different precisions permitted for each autosampler. If an
invalid injection volume is entered, even if it is in the permitted injection volume range, then the
acquisition does not start as per the LC driver design. For example:

For the ExionLC AC autosampler, the injection volume setting range and permitted increment
and precision is shown in the following table:

Table 1 ExionLC AC Autosampler Injection Volume Setting

Injection volume setting range 0.1 μL to 50 μL (standard), 0.1 μL to 100 μL (optional)

0.1 μL to 0.9 μL in 0.1 μL increments, 1 μL to 100 μL in
1 μL increments)

For the ExionLC AD autosampler, the injection volume setting range is shown in the following
table:

Table 2 ExionLC AD Autosampler Injection Volume Setting

Injection
volume setting
range

Total injection 0.1 μL to 50 μL

0.1 μL to 9.9 μL: 0.1 μL increments; 10 μL to 50 μL: 1 μL
increments
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Table 2 ExionLC AD Autosampler Injection Volume Setting (continued)

Loop injection Select either loop of 5 μL or 20 μL capacity.

0.1 μL to 9.9 μL: 0.1 μL increments; 10 μL to 20 μL: 1 μL
increments

For a Shimadzu autosampler, refer to documentation that came with the autosampler.

The minimum advanced permissions required by the Analyst software to store a result
file

For the minimum permissions required to store a result file, refer to the following figure.
(AN-1994)

Note: If the Analyst software user is in multiple domain user groups, then the folder permission
for the user is a cumulation of the permissions assigned to each of these groups.

Figure 3 Permission Entry for Analyst Data Dialog

As of Analyst 1.7.3 HotFix 2, the grouping behavior for analytes in the Analyst Reporter
has changed
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If analytes are to be included in same analyte group, then the analyte names must end with a
space and then an integer. Characters from the start of the analyte name to immediately before
the last space character must be the same. Analyte names have always been case sensitive.
Thus, Morphine 3 and Morphine 4 are put in the same group, and Morphine Dihydro 1 and
Morphine Dihydro 2 are put in the same group. However, analytes with names such as QAXL
357 1 and QAXL 225 2 would not be put in the same group. To put these analytes together, the
user must give the analytes a different name.

Before, analytes that belonged to different analyte groups, had names that started with the same
characters, and one of these analytes ended in 1 were put in the same group. For example:

• Morphine 1

• Morphine 2

• Morphine Dihydro 1

• Morphine Dihydro 2

(AN-1645)

Each time a hardware profile is activated, the time stamp of its hwpf file in Windows
Explorer changes.

By design, when a hardware profile is activated, the time stamp of its hwpf file changes. This is
because specific parameters must be read from the mass spectrometer and the hardware profile
manager to update the hwpf file during the activation process. (AN-1803)

Network acquisition: Special Acquisition Administrator Account

If the Special Acquisition Administrator Account option is not used for network acquisition,
then the user logged on to the Analyst software must have Delete rights for the
WIFF_CACHE_BACKUP folder in the D:\Analyst Data folder. If the Special Acquisition
Administrator Account option is selected for network acquisition, then the user logged on
to the Analyst software does not need access rights to the WIFF_CACHE_BACKUP folder in
D:\Analyst Data folder. However, the Special Acquisition Administrator Account must
have, at a minimum, Modify rights, with Delete rights, included for the WIFF_CACHE_BACKUP
folder. For more information about the Modify permission, refer to the following figure.
(AN-1994)
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Figure 4 Advanced Permissions

For more information about the Special Acquisition Administrator Account, refer to the
Analyst software 1.7.3 document: Laboratory Director Guide.

The ExionLC 2.0 software driver is not reverted to the version installed by the Analyst
software 1.7.3 after the Analyst 1.7.3 HotFix 2 is removed

When the Analyst 1.7.3 HotFix 2 is removed, the ExionLC 2.0 software driver version 1.0.0.91
stays. The driver is not reverted to version 1.0.0.83, which was installed with the Analyst 1.7.3
software. If the ExionLC 2.0 system is to be used with the Analyst software 1.7.3, then remove
the Analyst software 1.7.3 first, and then install the Analyst software 1.7.3. (AN-2910)

Acquisition methods containing four pumps and created in a version earlier than the
Analyst 1.7 with HotFix 3 cannot be opened in newer versions of the Analyst software

If an acquisition method uses four pumps and is made in a version earlier than the Analyst
software 1.7 with HotFix 3, then this method cannot be opened in the Analyst software 1.7 with
HotFix 3 or in newer versions of the Analyst software. The method must be made again using
the new hardware profile made in the Analyst software 1.7 with HotFix 3 or a later Analyst
software version. (AN-2818).

If pressure traces from Agilent or ADD are enabled, then they are shown under Show
Auxiliary Traces

In version 1.7.3, or later, of the Analyst software, the pressure traces from Agilent or ADD, if
enabled, are shown under Explore > Show > Show Auxiliary Traces.

Acquire each sample to a different data file if an ExionLC PDA or a Shimadzu PDA is used

We recommend that each sample be acquired to a separate data file if an ExionLC PDA or
a Shimadzu PDA is used. Doing so can prevent intermittent batch stoppages that are caused
when large amounts of data are written to a single file. (AN-1823, AN-2920, AN-2901)

Do a system check on Shimadzu and ExionLC PDAs to make sure the lamps are still in
good condition

A system check should be done on Shimadzu and ExionLC PDAs before data acquisition to
make sure that the lamps are still in good condition and do not cause poor data. This can be
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done by directly connecting to Shimadzu modules using the Ethernet connection and entering
the IP address in a web browser, external to the Analyst software. Starting from Analyst 1.7.3
HotFix 2, batch acquisition will not stop when the system receives an error message from the LC
driver about the PDA detector lamp usage time. A warning that the PDA detector lamp usage
time cannot be updated will be logged in the system Event Viewer. (AN-3214)

The expected RT is not automatically updated when integration parameters are changed
during quantitation peak review in the Analyst software

From the Analyst software version 1.7 and later, the expected RT is not automatically updated
when integration parameters are changed during quantitation peak review in the Analyst
software. The expected RT entered or selected by the user is kept. (AN-861, AN-869)

The audit trail Full User Name column has changed

In the Analyst 1.7.1 Patch for RODC Network, the Analyst software 1.7.2, and the Analyst
software 1.7.3 with or without HotFix 1, the audit trail Full User Name column shows the Full
Name of the user account, as stored in the Windows Server Active Directory. The Display
Name and Full Name of the user account are typically the same, but they do not have to be.
The network administrator can make them different.

However, from Analyst 1.7.3 HotFix 2 and later, the audit trail Full User Name column shows
the Display Name of the user account, as saved in the Windows Server Active Directory, unless
the Display Name field is empty in the Active Directory, in which case the Full User Name is
shown.

Note: The e-mail address of the user (the logon name used for the Analyst software) will be
used in the Full User Name column if the Analyst software cannot get the full name or display
name of the user because there is no access to the network. (AN-2447)

The toolbar in the Analyst software might not refresh correctly when scaling is changed

The toolbar might not refresh correctly under the following conditions:

• The user moved a remote desktop session window in which the Analyst software was open
from one monitor to another with a different monitor scaling setting, minimized the Analyst
window and then maximized it.

• The user connected remotely to a workstation with the Analyst software installed from a
computer using a monitor with a different scaling setting from what was set on the workstation
monitor, logged on the Analyst software and left the software open, ended the remote
session, and then logged on directly to the workstation on which the Analyst software was left
open.

The right side of the software toolbar where there are no toolbar icons cannot be seen. If
users change between modes, then the toolbar icons from the previous mode might persist
in the user interface and cannot be clicked, and some icons on the toolbar look like they are
shown twice. The workaround is to close the Analyst software and then open it again. This
is a Microsoft behavior where some applications do not respond to scaling changes until the
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applications are closed and then opened. To prevent the issue during a remote desktop session,
make sure that the Analyst software is closed before stopping the remote desktop session,
and then start the next remote desktop session. Do not move the remote desktop session
between monitors with different scaling settings. Alternatively, use the same scaling setting on
all monitors connected to the computer used to connect remotely to the Analyst software. For
example, set all monitors to 125% scaling. To prevent any display issues, when logging on
directly to the Analyst workstation, make sure to close the Analyst software before stopping the
last remote session or use the same scaling setting on the Analyst workstation monitor and the
remote desktop monitor. (AN-3205)

National Instrument ADC card support

The older model of National Instrument ADC card (PCI-6032E) is not supported in Analyst 1.7.3
HotFix 2 or later versions.

Where to Get Help
• Analyst Software 1.7.3 Release Notes

• Analyst Software 1.7.3 Installation Guide

Known Issues and Limitations
An incorrect response time might be used on Shimadzu SPD-40/40V UV detectors with
SCL-40/CBM-40/CBM-40 Lite ROM version earlier than 1.64.

If firmware versions earlier than 1.64 are used on a Shimadzu SCL-40, CBM-40, or CBM-40
Lite controller connected to a Shimadzu SPD-40/40V UV detector, then an incorrect interaction
between the Response mode and the Sampling time causes an incorrect response time. If the
response mode for the SPD-40/40V is set to Fast/Standard/Slow, then analysis is done with
response times of 0.5 s, 1.0 s and 2.0 s, respectively, regardless of the Sampling setting. There
is some influence on the data.

Workaround: Change the Response mode to Other, and then set the numeric value field to the
response time value or to a value that is less than the related sampling time. As an alternative,
use SCL-40/CBM-40/CBM-40 Lite firmware version 1.64 or later.

To print a pdf file from the Analyst software requires the user to have Delete rights to the
folder where the pdf file is saved

In the Analyst software, when a file such as a Results Table, File Information, data list is printed,
to a pdf file in a folder to which the user does not have Delete rights, the user gets a message
about not having permission to modify files in the location. If this issue occurs, then do the
following.

1. Click OK in the message.

2. Save the file again using the same name.
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3. Click Yes to replace the empty file that was created when the file was saved the first time.

This issue cannot be fixed because the function is in the Microsoft SDK and not in the Analyst
software. (AN-2756)

The VICI Valco 2-position 10-port valve shows an anomalous serial number and an empty
version in File Info in Analyst 1.7.3 HotFix 1 or an earlier version

The File Info of a data file acquired with a VICI Valco 2-position 10-port valve in Analyst 1.7.3
HotFix 1 or earlier shows an empty FW version and an anomalous serial number. Record the
serial number from the hardware label, if required. (AN-3220)

For integrated Agilent LC devices, the LC run stops when the mass spectrometer stops
acquiring data, even if the LC run time is longer than the MS run duration

For Agilent devices that are directly controlled in the Analyst software and not through the
Analyst Device Driver (ADD), the LC run stops when the mass spectrometer stops acquiring
data, not at the pump stop time, even if the pump run time is longer than the MS duration. This
issue occurs with or without Scheduled Ionization enabled. Also, the Agilent pump trace, if
enabled, starts at the pre-rinse and not the injection time. Thus the trace is shown from 0 to MS
end time + approximately 0.5min.

Workaround: configure the Agilent devices with the ADD software 1.4 if the LC run time is longer
than the MS run duration. (AN-2657)

Analyst 1.7.3 HotFix 2
Install the HotFix
Prerequisites

• The Analyst software 1.7.3 is installed.

Note: If the Analyst 1.7.3 HotFix 1 is installed, then the HotFix 1 will be silently removed
before Analyst 1.7.3 HotFix 2 is installed.

1. Log on to the computer as a user with Administrator privileges.

2. Stop any acquisitions that are in progress and then deactivate the hardware profile.

3. Close the Analyst software.

4. Download Analyst 1.7.3 HotFix 2 from sciex.com/software-support/software-downloads.

Tip! To prevent possible installation issues, save the file to a location other than the
computer desktop and then disconnect any external USB storage devices before the start of
the installation.
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5. After the download is complete, right-click the Analyst1.7.3HF2.zip file.

6. Click Extract All, browse to and select the destination folder, and then click Extract.

7. Browse to and then double-click the setup.exe file.

8. Follow the on-screen instructions to complete the installation.

9. SCIEX 3500, 4500, 5500, 5500+, 6500, and 6500+ systems: Go to the section: Update the
Firmware.

10. Open the Analyst software, and then activate the hardware profile. Refer to the
documentation for the Analyst software.

Analyst 1.7.3 HotFix 2 Installation Using a
Deployment Tool
Use this procedure if the Analyst software 1.7.3 is installed and a deployment tool is used to
install the HotFix.

Install the HotFix Using a Deployment Tool
Prerequisites

• The Analyst software 1.7.3 is installed.

The Analyst 1.7.3 HotFix 2 can be installed with a deployment tool, such as Microsoft
Endpoint Configuration Manager (MECM), using either a Windows administrator account or a
non-administrator SYSTEM account.

1. Use the deployment tool to make the AnalystTemp folder on the C:\ drive.
The software installation log file will be saved in this folder.

2. Run the following silent install command from the installation files location:
setup.exe /s /v/qn /v”/l* “c:\AnalystTemp\analyst173HF2.txt”” /v/
norestart

3. Restart the computers on which the Analyst software was installed.

4. SCIEX 3500, 4500, 5500, 5500+, 6500, and 6500+ systems:

a. Go to the section: Update the Firmware.

b. Open the Analyst software, and then activate the hardware profile. Refer to the
documentation that comes with the Analyst software.
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Systems using the AAC Security Database:
Fresh Installation of the Analyst Software 1.7.3
Using a Deployment Tool
Use this procedure to install the Analyst software 1.7.3 if the Analyst software will use the AAC
security database.

Install the Analyst Software 1.7.3 Using a Deployment Tool
Note: This installation option was not supported in the Analyst software 1.7.3 release.

The Analyst software can be installed with a deployment tool, such as Microsoft Endpoint
Configuration Manager (MECM), using either a Windows administrator account or a non-
administrator SYSTEM account.

If the SYSTEM account is used, then the users on the workstations where the Analyst software
will be installed do not need to have administrator rights in Windows.

This procedure applies to new installations that use the Analyst Administrator Console (AAC)
security database.

1. Make the AnalystTemp folder on the C:\ drive using the deployment tool.
The software installation log file will be saved in this folder.

2. (Omit this step if only the AAC security database will be used to log on to the Analyst
software workstations, and if users will never switch between the local security database
and the AAC security database when logging on to the Analyst software workstations.) If
the SYSTEM account is used, then make the SDBInfo registry key and deploy it with the
deployment tool.

Note: The SDBInfo registry key is not required if a Windows administrator account is used
to deploy the software.

All Value Name entries must use the String Value type. At least one of User or Group
must be specified. Refer to the table: Table 3. For an example SBDInfo registry key, refer to
the following figure.

Figure 5 Example SBDInfo Registry Key

[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SciexSccm\Analyst\SDBinfo
]
"UseMixedMode"="Yes"
"Domain"="DomainName"
"UserName"="First.Last"
"UserType"="Administrator"
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"GroupName"="SharedAccounts"
"GroupType"="Operator"

Table 3 SBDInfo String Value Requirements

String Value Comment

Value Name Value Data (Example)

UseMixedMode Yes Yes: Mixed Mode will be
used in the Analyst software

No: Integrated Mode will be
used in the Analyst software

Note: This value string is
optional. If not present, then
Integrated Mode will be used
in the Analyst software.

Domain DomainName The name of the domain to
which the user name and
group name belong. This
value string is mandatory.

UserName FirstName.LastName The name of the domain
user who will log on to
Windows on the computers
where the Analyst software
will be installed.

UserType Administrator The Role type for the
user in the security
configuration for the Analyst
software. The default
roles include Administrator,
Analyst, Operator, End
User, QA Reviewer, and
Supervisor.

GroupName ShareAccounts The Group name on the
defined domain.
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Table 3 SBDInfo String Value Requirements (continued)

String Value Comment

Value Name Value Data (Example)

GroupType Operator The Role type for the
group in the security
configuration for the Analyst
software. The default
roles include Administrator,
Analyst, Operator, End
User, QA Reviewer, and
Supervisor.

3. To install the software, use the deployment tool to run the following silent install command
from the installation files location:
setup.exe /s /v/qn /v”/l* “c:\AnalystTemp\analyst.txt”” /v/norestart

4. Use the software deployment tool to install the Analyst 1.7.3 HotFix 2. Refer to the section:
Install the HotFix Using a Deployment Tool.

5. Add the AnalystAdminConsole registry key, and then deploy it with the deployment tool.

All Value Name entries must use the String Value type. Refer to the table: Table 4. For an
example AnalystAdminConsole registry key, refer to the following figure.

Figure 6 Example AnalystAdminConsole Registry Key

[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\PE
Sciex\Analyst\AnalystAdminConsole]
"Default Workgroup"="WorkgroupName"
"Server"="ServerName"
"Use Project Security"="Yes"
"Use Security Server"="Yes"

Table 4 AnalystAdminConsole String Value Requirments

Value Name Value Data (Example)

Default Workgroup WorkgroupName

Server ServerName

Use Project Security Yes

Use Security Server Yes
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6. To connect to the AAC server 3.0, log on to the AAC 3.1 client as an AAC administrator from
any workstation where the Analyst 1.7.3 HotFix 2 has been installed.

Note: Before the AAC server 3.1 was available, the AAC administrator could not add a
workstation directly from the AAC server 3.0 computer.

7. Add the Analyst software workstations to the workstation pool for all of the workstations
where the Analyst software 1.7.3 has been newly installed and the AAC security database is
to be used.

8. Add the workstations to the workgroup defined for the Default Workgroup in the
AnalystAdminConsole registry key in step 5.

9. Before opening the Analyst software, restart the computers on which the Analyst software
was installed.

10. SCIEX 3500, 4500, 5500, 5500+, 6500, and 6500+ systems:

a. Go to the section: Update the Firmware.

b. Open the Analyst software, and then activate the hardware profile. Refer to the
documentation that comes with the Analyst software.

Update the Firmware
Use the ConfigUpdater.exe program to update the system firmware to PIL2007 for the
SCIEX 3500, 4500, 5500, 5500+, 6500, and 6500+ systems. The configuration tables have not
changed. Refer to the document: Software Installation Guide for the Analyst software 1.7.3 for
information about configuration tables.

1. Browse to the Analyst\Firmware\ConfigUpdater folder, and then double-click
ConfigUpdater.exe. This folder is in the C:\Program Files (x86)\ folder.
The Configuration Table Update Program page opens.

Tip! The ConfigUpdater.exe program can also be started from the shortcut: Start >
SCIEX Analyst > ConfigUpdater

2. Select the Ethernet interface.
The ConfigUpdater utility opens and then identifies the new firmware version to be installed.

Note: The ConfigUpdater utility will reset the mass spectrometer. This is normal and is
required by the update process.

3. Click Next.
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Figure 7 Upload Confirmation Prompt

4. Click OK, and then wait until the message Uploaded firmware is ready is shown.

5. Click OK.
The Firmware/Configuration Table Update Program dialog with a list of supported
instruments opens.

6. Click Next.

A dialog with the following message opens: Your current configuration
table is: <header of the current configuration table> file. Your
instrument is upgraded to the latest firmware configuration table.
Click Cancel to exit this program or click Downgrade if you wish to
upload another Configuration Table.

7. Click Cancel to close the utility.

Remove the HotFix
1. Deactivate the hardware profile and then close the Analyst software.

2. Open the Programs and Features control panel.

3. Select Analyst 1.7.3 HotFix 2 from the list and then click Uninstall.
The HotFix is removed from the program list. After the HotFix is removed, the software
is reverted to the Analyst 1.7.3 software. However, the ExionLC 2.0 software driver is not
reverted to the previous version.

Updated Files
The HotFix 2 makes the following changes to the Analyst, AB SCIEX, and Common Files
folders. The folders are in the C:\Program Files (x86)\ folder.

Analyst\Bin (All files, excluding one, are updated)

• AdminConsole.dll (Updated unless HotFix 1 was installed)

• Analyst.exe (Updated unless HotFix 1 was installed)

• Analyst.reg
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• AnalystLauncher.exe (Updated unless HotFix 1 was installed)

• AutosamplerDB.adb (Updated unless HotFix 1 was installed)

• AuditTrailManagerCtrl.ocx
• AutosamplerDB_SIL40_SIL30AC_SIL30ACM_AlphaDWP96.adb (added unless HotFix 1

was installed)

• AutosamplerDBServer.adb (Updated unless HotFix 1 was installed)

• BatchDir.dll (Updated unless HotFix 1 was installed)

• CSISShimLC40.dll (Updated unless HotFix 1 was installed)

• DDISExion2LC.dll (Updated unless HotFix 1 was installed)

• DDISSSciexLC.dll (Updated unless HotFix 1 was installed)

• DDISShimadzu.dll (Updated unless HotFix 1 was installed)

• ExploreDir.dll (Updated unless HotFix 1 was installed)

• HP1100lcMethodEditor.ocx
• LCPumpMethodSvr.dll (Updated unless HotFix 1 was installed)

• MMSecurity.dll
• PEIUtils.dll
• ProjectFront.dll
• QuantFullMethodEditor.ocx (Updated unless HotFix 1 was installed)

• QuantIntegration.dll (Updated unless HotFix 1 was installed)

• QuantMethod.dll (Updated unless HotFix 1 was installed)

• QuantRT.ocx
• QuantWizard.dll (Updated unless HotFix 1 was installed)

• ReportEngine.ocx
• SecurityConfigDir.dll (Updated unless HotFix 1 was installed)

• StatusSvr.dll (Updated unless HotFix 1 was installed)

• TuneDir.dll
• UserManager.dll
• DDVAValco.dll
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Analyst\BinEx (All files are updated unless Analyst 1.7.3 HotFix 1 was installed)

• MimicInstrumentHost.exe
• ShimadzuLCMimic.Interop.Common.dll
• ShimadzuLCMimic.Interop.Defines.dll
• ShimadzuLCMimic.Interop.Interfaces.dll
• ShimadzuLCMimic.Interop.LCMimic2Defines.dll
• ShimadzuLCMimic.Interop.ShimLCConfig.dll
• ShimadzuLCMimic.Interop.ShimLCControler.dll
• ShimadzuLCMimic.Interop.ShimLCCore.dll
• ShimadzuLCMimic.Interop.ShimLCMethod.dll
• ShimadzuLCMimic.Interop.ShimLCSetup.dll
• ShimadzuLCMimic.Interop.ShimLCStatus.dll
• ShimadzuLCMimic.ServerCommon.dll
• ShimadzuLCMimic.ServiceInterfaces.dll
• VDISSciexLC.exe

Analyst\Firmware
• PIL2007 (added)

Analyst\Firmware\ConfigUpdater (All files are added)

• AxInterop.ComctlLib.dll
• AxInterop.InetCtlsObjects.dll
• AxInterop.MSCommLib.dll
• AxInterop.MSFlexGridLib.dll
• AxInterop.MSWinsockLib.dll
• ConfigUpdater.exe
• ConfigUpdater.exe.config
• ConfigUpdater.pdb
• ConfigUpdater.xml
• Interop.ComctlLib.dll
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• Interop.InetCtlsObjects.dll
• Interop.MSCommLib.dll
• Interop.MSFlexGridLib.dll
• Interop.MSWinsockLib.dll
• Interop.Scripting.dll
• UpdateConfig.ini

Analyst\BinEx2 (All files are updated unless Analyst 1.7.3 HotFix 1 was installed)

• ExionInterop.Common.dll
• ExionInterop.Interfaces.dll
• ExionInterop.LCController.dll
• ExionInterop.LCCore.dll
• ExionInterop.LCDefines.dll
• ExionInterop.LCSetup.dll
• ExionInterop.LCStatus.dll
• IntegratedLCSystemDriver.DriverCore.Base.dll
• IntegratedLCSystemDriver.DriverCore.ClientComponents.dll
• IntegratedLCSystemDriver.DriverCore.ServerComponents.dll
• LCMimicDmo.exe
• de-DE subfolder
• en-US subfolder

Common Files\SCIEX\LLDriver (All files are updated unless Analyst 1.7.3 HotFix 1 was
installed)

• AliasBase_icf.dll
• AliasDCP_icf.ocx
• AliasRes_icf.dll
• ASBase_icf.dll
• ASBaseDCP_icf.dll
• ASCIIDevices_icf.dll
• CfgCntl.dll
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• CfgCntlProxy.dll
• CfgCntlSrv.exe
• CT21OvenBase_icf.dll
• CT21OvenDCP_icf.ocx
• CT21OvenRes_icf.dll
• IdentifyLocal.dll
• IdentifySrv.exe
• IdentifySrvProxy.dll
• InstrCntlANASM22L_icf.dll
• InstrCntlANBase_icf.dll
• InstrCntlANP81L_icf.dll
• InstrCntlANV41S_icf.dll
• InstrCntlBase_icf.dll
• InstrCntlCT21_icf.dll
• InstrCntlMc_icf.dll
• InstrCntlP61L_icf.dll
• InstrCntlS2650_icf.dll
• InstrDADBase_icf.dll
• InstrDADDCPBase_icf.dll
• InstrDADRes_icf.dll
• InstrS2650DCP_icf.ocx
• KBase_icf.dll
• KBaseDCP_icf.dll
• KNGeneral_icf.dll
• KPumpBase_icf.dll
• KPumpP61LDCP_icf.ocx
• KPumpP81LDCP_icf.ocx
• KPumpRes_icf.dll
• KWCUnits.dll
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• LogConfig.exe
• McMonitor_icf.dll
• OEMFolderAccess.dll
• RCServer.dll
• SciLexer.dll
• SparkProtocol_icf.dll
• SType.prm
• SvalvesBase_icf.dll
• SvalvesDCP_icf.ocx
• SValvesRes_icf.dll
• SxASController.exe
• SxControllerBase.dll
• SxDADController.exe
• SxOvenController.exe
• SxPumpController.exe
• SxPumpPController.exe
• SxSVController.exe
• SxVIBase.dll
• SxVIInterfaces.dll
• SxWSController.exe
• Units.txt
• WashStationBase_icf.dll
• WashStationDCP_icf.ocx
• WashStationRes_icf.dll
• xerces-c_2_6.dll

Analyst\Help
• Analyst 1.7.3 HotFix2 Release Notes.pdf (Added)

• Administrator_Console.chm (Updated)
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Tip! A shortcut to the Release Notes can be found in this location: Start > SCIEX Analyst

AB SCIEX\AnalystReporter\bin (Files are updated)

• Sciex.Report.DataSource.Analyst.dll
• Sciex.Report.Engine.dll

C:\Program Files\AB
SCIEX\ReporterOfficeAddins\TemplateContentControlManager (files are updated)

• TemplateContentControlManager.dll.manifest
• TemplateContentControlManager.vsto

Contact Us
Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.
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To see this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.

To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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This document is provided to customers who have purchased SCIEX equipment to use in the operation of
such SCIEX equipment. This document is copyright protected and any reproduction of this document or
any part of this document is strictly prohibited, except as SCIEX may authorize in writing.
Software that may be described in this document is furnished under a license agreement. It is against the
law to copy, modify, or distribute the software on any medium, except as specifically allowed in the license
agreement. Furthermore, the license agreement may prohibit the software from being disassembled,
reverse engineered, or decompiled for any purpose. Warranties are as stated therein.
Portions of this document may make reference to other manufacturers and/or their products, which may
contain parts whose names are registered as trademarks and/or function as trademarks of their respective
owners. Any such use is intended only to designate such products as those manufacturers' products and
does not imply any right and/or license to use or permit others to use such manufacturers' and/or their
product names as trademarks.
SCIEX warranties are limited to those express warranties provided at the time of sale or license of its
products and are the sole and exclusive representations, warranties, and obligations of SCIEX. SCIEX
makes no other warranty of any kind whatsoever, expressed or implied, including without limitation,
warranties of merchantability or fitness for a particular purpose, whether arising from a statute or
otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed,
and assumes no responsibility or contingent liability, including indirect or consequential damages, for any
use by the purchaser or for any adverse circumstances arising therefrom.
(GEN-IDV-09-10816-E)

For Research Use Only. Not for use in Diagnostic Procedures.
Trademarks and/or registered trademarks mentioned herein, including associated logos, are the property
of AB Sciex Pte. Ltd., or their respective owners, in the United States and/or certain other countries (see
sciex.com/trademarks).
AB Sciex™ is being used under license.
© 2023 DH Tech. Dev. Pte. Ltd.

AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256
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